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ABSTRACT

PLANT SCANNER:

A HANDHELD PDA USING RFID TAGS FOR CHILD VISITORS TO

THE MICHIGAN 4-H CHILDREN'S GARDEN

By

Apama Rajan Ramchandran

This thesis project investigates the viability of using interactive handheld and RFID

technology in the Indoor 4-H Children’s Garden at Michigan State University. The

project involves the integration of technologies such as RFID, Flash, Embedded Visual

Basic and XML to develop a usable interface on a Pocket PC.

The Plant Scanner Project is designed to teach children introductory plant biology and

enhance their exploration of the Indoor 4-H Children’s Garden. The results from initial

testing suggest that students learn more about plants by using the Plant Scanner, students

use the technology with ease, students engage with the technology, the Plant Scanner

works better in the outdoor garden. and that learning with the Plant Scanner is enhanced

when a plant expert accompanies children.
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CHAPTER 1

INTRODUCTION

Description

Interactive handheld technology is being used in the Indoor 4-H Children’s Garden for

the first time. The Plant Scanner Project uses a handheld device (PDA) to teach children

introductory plant biology and enhance their exploration ofthe indoor children’s garden.

The project bridges the real world (the children’s garden) with a virtual world that exists

inside the handheld device.

A child walks through the 4-H Children’s Garden with a handheld device and stops in

fiont of a plant- let's say a tomato plant. In front of the tomato plant is a physical sign. If

the child waves the PDA over the tomato sign, information about the tomato plant

appears in the interface. The PDA in this case is like a ‘plant-scanner.’ The Plant

Scanner helps you ‘see’ what is not visible. As the child explores the garden she could

‘scan’ other plants with the plant-scanner. This action would bring up information on that

plant including the name ofthe plant, a picture of the plant and other information that

may not be visible when looking at the real plant. For example, she could see a picture of

the root that is buried and understand what the root structure is like and what the root

does. She could also explore the other plant parts such as stem, leaf, flower, fruit, and

seed discovering what they look like and what they do. Pictures of the plant in each ofthe

four seasons can be accessed in the cycle’s section. She could also see how the plant is

used for beauty, food, medicine, bio-agent. fun, arts and crafts. By interacting with the



garden in this way, she can get a better understanding of the various parts, life cycles, and

uses of the particular plant.

The sign next to the plant has an RFID tag and the handheld PDA has an RFID reader, so

when the child waves the PDA in front of the Sign, data is passed to the PDA. This action

makes information appear on the screen. But to the child. the act ofwaving the device in

front ofthe sign brings up the information. These combined technologies create an

interactive interface that enables the learner to call up images and text information about

various plants. It provides an interface that is student directed and controlled and can lead

to exploration throughout the garden. The Plant Scanner Project supports learning and

adds to the child’s experience.

Elementary school students, particularly those in third grade through eighth grade who

visit the indoor children’s garden at Michigan State University will be using the Plant

Scanner Project. The 4-H Children’s Garden is a popular destination for local school

children, with over 500 students visiting each week in the spring and fall. The projected

audience is even greater if the Plant Scanner is used in the Outdoor 4-H Children‘s

Garden!

Goals

The overall goal of the Plant Scanner project is to elegantly integrate PDA technology

into the 4-H Children’s Garden experiences in ways that will enhance and expand

children’s curiosity, wonder and discovery.



To achieve this goal the Plant Scanner Project will: 1) expose young learners to plant

biology- life cycles of plants. uses of plants. parts of plants in a fun and appealing ways.

2) explore ways to best integrate virtual and real experiences, 3) enhance the Indoor

Children’s Garden experience for children, 4) encourage children to explore the garden

and learn through technology (garden plus technology is even better than either one

alone- technology scaffolds), 5) investigate the viability of using handhelds in the garden,

6) look at new RFID (Radio Frequency Identification) technologies and their interaction

with handheld devices.



CHAPTER 2

LITERATURE REVIEW

Introduction

The Plant Scanner Project involves the use of a handheld device to enhance and expand

experiences in the 4-H Children’s Garden. Interest in handheld technology is growing,

especially in museums. Schools are becoming more interested in the technology.

Proponents ofhandheld technology believe that because it is more affordable and more

portable than other technologies its’ popularity will grow.

What is a PDA?

A handheld or PDA (Personal Digital Assistant) has been described as a “small, low-cost,

highly versatile, mobile computer” (Avanzato, n.d., para.1). It has also been described as

a “small, handheld device that provides tools to enhance personal productivity” (Deneen,

2001, para. 1). PDA‘s are mainly designed to be Personal Information Managers (PIMs)

and usually include calendar, address book, task lists and notes. Most PDA’S have a pen-

based (stylus) input and usually have handwriting recognition. Some have an inbuilt

keyboard or an external keyboard connected to it. Many PDA’s are now equipped with

wireless connectivity and Bluetooth, while other PDA’s come with expansion slots which

could host a number of add-ons including GPS and wireless connectivity. The two most

popular kinds of PDAs are the Palm OS PDAs and the Microsoft Pocket PC.



How are PDA’s being used in museum environment/city guides?

Exploratorium Guidebook Project

The Electronic Guidebook Project (http://wwwexploratoriumedu/guidebookl) was

created at the Exploratorium in San Francisco in partnership with researchers from

Hewlett Packard Labs and The Concord Consortium.

The Electronic Guidebook project investigated “the use of handheld computing devices

and wireless networks to support a richer learning experience for science museum

visitors” (Exploratorium, n.d.. para. 1). The project’s goal Was to find out how a “network

of mobile devices. wireless networks and web-based content" (Exploratorium, n.d.. para.

1) would allow users to “engage in a continuum of activities before, during. and after a

museum visit to support a deeper engagement with the exhibits and the ideas they can

communicate” (Exploratorium, n.d., para. 1).

The Electronic Guidebook project's technology enables users to interact with exhibits

with a wireless device and have URL‘S sent to their PDA. This project made use of a Pi-

station (point-of-information station) that included a digital camera, infrared beacon, and

RFID transmitter/receiver. The Pi-station is placed next to an exhibit. The users use a

handheld device like a PDA to interact with these stations. The infrared beacon sends a

URL to the handheld device when it is close to the exhibit. The corresponding webpage is

then automatically downloaded from the content server. In this way. text, images, video,

and audio are delivered to the PDA. In addition users bookmark the exhibits. take digital



pictures with the camera near the exhibit and have a record of their visit. This user

information can be stored in a “My Exploratorium” web page that that can be accessed

later.

A study led by Sherry Hsi asked teachers, staff, museum members, and teens to describe

their experiences after working with the Electronic Guidebook Project. Generally the

participant comments were positive. Many commented that the handheld resources

helped them “to think about and interact with the exhibits in new ways” (Hsi, 2002, p. 2).

None ofthe participants had problems swiping the RFID devices with the handheld.

Although most comments were positive, some participants complained ofthe heaviness

ofthe handheld and one participant “felt a sense of isolation” and “expressed a concern

that the handheld interfered with exhibit” (Hsi, 2002, p. 2).

1'ate Museum

The Tate Museum launched a multimedia tour that incorporated wireless technologies

and handheld computing in July 2002 (httn://www.tate.orng/modem/multimediatour/

). The tour allowed visitors to see background information about the exhibits in a variety

of different formats on a handheld device. These included still images, videos, and

additional context for the exhibits. Visitors could listen to expert audio commentary

about works while the works were being highlighted simultaneously on their PDA’S.

There were interactive screens where the visitor could respond to the works, answer

questions, and create their own sound track about the works.



The tour used a wireless network that pinpointed the visitor‘s location and sent them

relevant information. The information stored on a central server can be limitless and

easily updated. Since the tour was connected to a network the museum can broadcast

messages to the visitor or send automatic alerts when an event is about to start. The

visitor can also have information about a piece of art sent to their home e-mail address.

852 visitors who took the Tate Museum Multimedia tour completed evaluation forms

based on their experiences. About 70% of the visitors said they spent more time in the

gallery with the multimedia tour than they normally would have. A similar percentage

said their visit was improved because ofthe multimedia tour. In general, older visitors

found the tour more difficult to use than younger people.

As long as the message was clear and the device was functioning properly, users did not

find multi-tasking between the PDA screen and the artwork to be a problem. Susie Fisher

reported, “Visitors can multi track with great case, even when the input tracks (audio.

screen. painting) are not synchronized with one another” (Tate, 2003, p. 2). The

multimedia tour made users look at the exhibit longer even though the screen

commanded attention. Long messages didn’t work, as the average user’s attention span

for the interactive message was shorter than just an audio tour. The help button helped

show users how to use the tour. Text got mixed responses; the more art-experienced

people liked the wall label information in their PDA, while others wanted more exciting

content.



Invisible Ideas

“Invisible Ideas” (http://www.invisibleideas.org[) is a location aware application that

gives users specific information about a site as they stroll along several parks in Boston.

It combines GPS technology Macromedia Flash and Pocket PC and is the first application

of its kind in the world.

The project consists of 147 art exhibits, each associated with a GPS waypoint (latitude

and longitude), scattered over three parks. When the user is within a certain radius of an

exhibit, the Invisible Ideas application triggers an event that plays the artist’s content, be

it-audio, graphical, or video. The content stops playing when the user is outside the

specified radius. As the users are walking, the application saves the users GPS co-

ordinates on 3 SD (Secure Digital) card on the PDA. When the user returns the PDA to

the gallery this SD card is removed and the information is saved to a database. A Flash

application then uses this data to draw the users walking path on a scaled map ofthe

parks.

This award-winning project has created a new location-aware technology platform to

explore ideas and develop further projects. SmartWorlds, the technology provider for

Invisible Ideas, has received requests from other communities to build similar projects.

To SmartWorlds CEO Giuseppei Taibi, Macromedia Flash MX is “the most flexible and

powerful development environment for any device, operating system, browser, or chip set

to create applications that integrate seamlessly with GPS technology” (Macromedia, n.d..

“The Benefits” section, para. 2).



Handhelds in the Classroom

Eliot Soloway, a researcher at the University of Michigan. argues that handhelds have

“emerged as a viable alternative to desktop and laptop computers” (Norris & Soloway,

2003, “Opportunity Knocks” section. para. 1) and will become the “primary computing

device for K-12 students” (Norris & Soloway, 2003, “Opportunity Knocks” section, para.

3). Desktops and laptops he argues “are overly complex, burdened with excess

functionality.” (Norris & Soloway, 2003, “Opportunity Knocks” section, para. 3) They

take away too much time from the teaching of ideas and require too much time to teach

the technology. Handhelds, unlike desktops and laptops, are portable so they can be

taken and used outside the classroom. Portability, accessibility, and cost make Soloway

think that schools will move towards handheld technology in the near future.

One scenario offered by Soloway and his colleagues is that of a 5m grade classroom

where each of the thirty students had handheld computers. In the first two days ofthe

science unit, the students researched inventors on the Internet. On the third day they used

software developed by Soloway‘s team to concept map on their handheld. The students

also used their handhelds to type and store notes. Students also sent information to each

other thus increasing collaboration in the classroom. This finding, the discovery of

increased collaboration with the use ofhandhelds was also shown in a study done by

researchers at Simon Fraser University and the University of California (Regan &

Inkpen, 2001 ). In their study. children aged 12 to 14 worked collaboratively to explore



genetic concepts. Both the Soloway and Fraser studies seem to suggest that handhelds

offer affordances, but collaboration is dependent on the design of the learning activity.

Soloway and his fellow researchers at the University of Michigan have conducted

multiple studies, most ofthem qualitative, on the affordances and constraints ofhandheld

technology and the supporting software. In a study with third to ninth graders using

handhelds, they found that students were more productive with handhelds, because they

produced more documents than the control groups. Students across the grades were also

more likely to revisit their notes when using handhelds. Easy accessibility to notes

supported this process. Soloway’s team concluded fiom these early studies “the handheld

computer will have more of an impact on teaching and learning in K-12 education than

the Internet has had” (Norris & Soloway, 2003, “Next Steps” section, para. 1).

Studying handheld computers and their effects on science learning in four seventh grade

classrooms, Soloway’s group found that the handheld itself increased student motivation

and engagement, while supporting the understanding of scientific ideas. Handhelds fit

into the school curriculum because they “are flexible enough to support a range of

learning activities and learning styles and they are affordable enough to make it feasible

for all students to have a truly personal computing device to support their own learning”

(Luchini & Quintana & Soloway. 2004. p. 1).

IO



Literature Review Conclusion

The use ofhandhelds is increasing in museums. Schools are usually slow in adopting new

technologies, but a handheld’s lower price and portability may make its’ purchase more

attractive. Researchers are starting to look closely at how handhelds within a curriculum

can promote learning and collaboration. More research needs to follow, so we can begin

to better understand how handhelds support learning.
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CHAPTER 3

TECHNOLOGY OVERVIEW

Introduction

This project uses a variety ofhardware and software technologies. The hardware

interface includes the Pocket PC (hp iPAQ h5550), a RFID reader (AWID MPR-1230)

plugged into a PC card expansion pack in the Pocket PC and various RFID “tags” (Texas

Instruments Vicinity Card Transponders) placed at different parts of the garden.

The software consists of a front-end Flash program and a backend embedded Visual

Basic program (eVB) that communicates with the RFID Reader. The eVB program

interacts with the RFID reader and transfers tag data to the Flash program with the help

of an XMLSocket connection.

The tag is activated by the RFID reader when the user waves the device (the Pocket PC

with an RFID reader) over a tag. The RFID reader reads the tag data with the help of the

eVB program and then passes this data to the Flash program through the XMLSocket

connection. The Flash program utilizes this data to display information about the plant.

This information includes pictures along with text information about the plant parts, plant

life cycle and the plant uses.

12



Background

In the beginning of this production thesis I consulted with John Turner, a multimedia

specialist at the Exploratorium in San Francisco. We discussed several options available

to enable interaction with the Pocket PC and the garden and hence make the project

location and context aware. Some ofthe options available were GPS, 802.11 positioning,

bar coding, and RFID.

GPS

“GPS is a satellite-based radio navigation system developed and operated by the US.

Department of Defense (DOD)” (US. Coast Guard Navigation Center, n.d.). GPS

satellites circle the earth twice each day in a precise orbit and transmit signal information

to earth. GPS receivers take this information to calculate the user’s exact location (Garim,

n.d.). The location accuracy for most equipment can range between 10 to 100 meters. The

military equipment has higher accuracy (up to 1 meter or less). The GPS receivers get

information such as the date, time, latitude, longitude, and altitude as string values from

the satellites.

The Plant Scanner Project is to be used in the Indoor 4-H Children’s Garden with a total

area of less than half an acre. GPS was ruled out since it has an accuracy of about 10 to

100 meters, and it doesn’t work well indoors due to weak satellite signals.

802.11 Positioning

802.11 refers to a family of specifications developed by the IEEE for wireless LAN

13



technology. 802.11 specifies an over-the-air interface between a wireless client and a

base station or between two wireless clients (Webopedia, 2004).

While GPS works outdoors, the satellite signal is not strong enough to work well indoors.

New forms of indoor positioning that use 802.11 wireless LAN are appearing in the

market. Indoor positioning requires special equipment that interacts with the wireless

network. There are no standards for these systems, so most solutions are vendor specific

(Geier, 2002, “Proprietary Technologies” section, para. 1).

One such system available is the Ekahau Positioning system (EPE) (Ekahau, n.d), which

locates laptops and PDA within 1 meter (3.5 feet) in less than a second (Geier, 2002,

“Proprietary Technologies” section, para. 2). The Ekahau system costs about $2995 to

track 5 devices and $4990 to track 15.

The Ekahau system was launched in July of 2003. With our limited budget, the Ekahau

system wasn’t the most ideal solution for this project.

Bar coding

A bar code is a pattern of dark bars and white spaces of varying widths that represent

numbers letters or symbols. Bar code labels are read with a scanner. The scanner

translates the barcode into numbers and letters that are passed to a computer.

14



The reason I didn’t choose barcodes was because I wanted to experiment with more

sophisticated RFID technology. There are several advantages to using RFID. which are

included in the next section.

RFID

RFID (Radio Frequency Identification) is the technology that uses radio waves to identify

people and objects (RFID Journal, n.d.). An RFID system consists ofan RFID tag (also

known as the transponder) and an RFID reader. The RFID tag consists of a small

microchip and an antenna. Data is stored in the tag, usually in the form of a unique serial

number. (RFID Journal, n.d.) RFID tags can be either "passive" (no battery) or "active"

(battery present). Active tags need a battery and are more expensive ($10 - $100) than

passive tags and have a read range of several meters (10 to 100 meters). Passive tags

don’t need a battery and have a read range between 10 mm to about 5 meters. They are

cheap, starting at about $0.25 (Wikipedia, n.d.). The vast majority of RFID tags are

passive in nature. This project uses passive tags.

The RFID reader acts as a transmitter/receiver. The reader transmits an electromagnetic

field that "wakes-up". the tag and provides the power required for the tag to Operate

(Zebra, 2004). The tag then transfers the data to the reader through the antenna. This data

is then read by the RFID reader and transferred to the Pocket PC or computer.

Unlike barcodes, RFID tags do not have to be line-of-sight. They only have to be within

the reader’s radio range. Also unlike barcodes. RFID tags can be read through most

15



materials. RFID tags are getting smaller and smaller some are 1/3 of a millimeter across

(Granneman. 2003. “RFID 10] ” section, para. 1).

RFID systems use many different frequencies. but generally the most common are low

(around 125 KHz), high (13.56 MHz) and ultra-high frequency, or UHF (850-900 MHz).

The MPR-1230 spans the high frequency (13.56MHz) (RFID Journal, n.d.)

The RFID reader used in this project was the AWID MFR-1230. a popular RFID reader

that is designed to slip into any third party handheld, notebook or tablet computer. (see

Figure 3.1)

  

  

AWID MPR -1230

(RFID Reader)

Pocket PC

Figure 3. 1 Pocket PC with MFR-1230 RFID Reader

It will read and write most leading smart labels or tags (AWID, 2003). The MFR-1230

reader uses the high frequency spectrum. The read range of the MFR-1230 is about 4 to 5



inches (AWID, 2003). I noticed during testing that the read range reduced to about 2 to 3

inches when the reader was protected by a rugged case.

There are several tags that are compatible with the AWID MPR-1230. I used RFID tags

made by Texas Instruments. The tag used in this project is a 13.56MHz Vicinity Card

Transponder (Texas Instruments Radio Frequency Identification Systems, 2002). (see

Figure 3.2). It supports the ISO-15693 standard and operates at a frequency of 13.56

MHz. Its’ dimensions are 85.6 mm x 54 mm x 0.76mm. and it weighs about 5 grams and

has a glossy finish. Its” operating temperature is -25°C to +50°C. It has a data retention

capacity of over 10 years. It is relatively cheap, about $5 per tag. The prices fall when

bought in larger quantities.

 

Figure 3. 2 13.56 MHz Vicinity card Figure 3. 3 13.56 MHz Encapsulated

Transponder (Texas Instruments) Transponder (Texas Instruments)

Another newly available tag that has the same frequency of 13.56MHz and the ISO-

15693 standard is the 13.56MHz-encapsulated transponder (Texas Instruments Radio

Frequency Identification Systems. 2003). (see Figure 3.3). It is designed to withstand

very harsh environments. It is black and about the size of a quarter. Its operating

temperature is -25°C to +90°C. It is designed for laundry tracking applications and can



withstand shock and vibration. It could be used in the outdoor garden where there are

more variations in temperature.

I decided to go with RFID technology, because the tags could be placed right next to the

exhibit (a plant in this case) and would enable a higher level of user interactivity. The

RFID tags are low maintenance and relatively cheap.

Embedded Visual Basic and XMLSocket connection

Sophisticated applications for the Pocket PC are usually built using embedded Visual

Basic (eVB) or embedded Visual C++ (eVC), since both languages offer deep integration

with Windows CE. Both languages facilitate various tasks including file system access

and network connectivity (Chia. 2002).

Due to security issues. browsers and their plugins like Flash cannot have the same deep

system access as eVB and eVC (Chia. 2002). This means that sophisticated applications

can be built that use a rich Flash interface as the front end and eVB or eVC middleware

or a backend program.

The Plant Scanner Project requires interaction with the RFID reader, which is inserted

into the expansion pack of the Pocket PC. Flash cannot communicate directly with the

reader, so instead a backend eVB program communicates with the RFID reader.

18



The eVB program communicates with the RFID reader and provides functions to read the

tag data. This custom program performs functions such as enabling the RFID reader,

setting the reader to read mode, reading tag data when the reader is in an enabled state

and passing this data to the XMLSocket object.

The XMLSocket object offers a convenient way for bi-directional communication

between a Flash and an eVB or eVC program (Chia, 2002). The XMLSocket object

creates persistent connections with a socket server. which could be running as a

component of an eVB or eVC program. These persistent connections are called sockets.

Once the socket is established, data can be sent and received across this channel. The

XMLSocket object is intended for XML data, but it can accept plain string data too. The

eVB program and XMLSocket connection for this project was written by my friend,

Vineet Bansal.

Flash for Pocket PC

Overview

Macromedia Flash allows Flash content to be developed once and deployed across

multiple platforms. browsers, and devices. Unlike desktop computers, mobile devices

have limited storage capabilities, so Macromedia Flash is an ideal solution. since Flash

files are compact and load quickly over low bandwidth connections. In addition. Flash

supports scripting capabilities and server-side connectivity to create engaging

applications, presentations, and data-driven content.
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Pocket PC refers to the class of PDA that runs the Microsoft Pocket PC Operating

system. The current version is Pocket PC 2003. There are “over 35 different

manufacturers of Pocket PC devices ranging from consumer to enterprise to ruggedized”

(Macromedia, 2003).

For a list of all the Pocket PC devices the Pocket PC OS see:

http://www.microsofi.com/windowsmobile/pocketpc/

The Pocket PC devices can have different specifications, but most ofthem share the

following characteristics: an Intel processor. 32-128 MB of RAM, 240x320 resolution,

64k color screen, built-in expansion slot for CompactFlash. SD, and MMC (Watrall &

Herber. 2003. p. 764).

The device used for this project is the HP iPAQ pocket PC h-5550. lts’ specifications are:

400 MHz Intel Xscale technology-based processor, 128 MB RAM, 240x320 resolution,

64 k color screen. integrated wireless, and Bluetooth. A PC card expansion pack plus was

also purchased to house the RFID reader and the extended battery. The extended battery

can increase the battery life of the pocket PC by 135% - 150% (HP, 2004).

Fontsfor Flash

The screen size in a PDA (240x320) is relatively small, so smaller font sizes were

required. Text in Flash. by default, is anti-aliased. This anti-aliased text becomes blurry



and difficult to read at smaller sizes. A solution to this is to use pixel fonts or optimize

the text using Alias Text (Watrall & Herber, 2003, p. 770).
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Figure 3. 4 Fonts for Flash

Using Pixel Fonts:

Pixel fonts are designed to be viewed at small point sizes and are not anti-aliased. The

fonts use pixels to create each character (Watrall & Herber, 2003, p. 770), so they remain

crisp and legible irrespective of screen size and resolution. However there are some

things to be considered while using pixel fonts (see Figure 3.4). Pixel fonts need to be in

increments of 8 (8, 16. 32) or as specified by the font creator. They need to be placed at

whole X and Y coordinates. 10 instead of 10.5 (Watrall & Herber, 2003, p. 770). This can

be done using the Property Inspector (Window>Properties) or the Info panel

(Window>Design Panels>lnfo).

If input or dynamic fonts are being used, then fonts need to be embedded or else they will

default to the Pocket PC system fonts (Watrall & Herber, 2003, p. 770). Pixel fonts don’t

usually come with Flash and need to be purchased separately. Some pixel fonts are

available at wwwfontsforflashcom and www.miniml.com.
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Optimizing Small Fonts:

One ofthe new features of Flash MX 2004 and Flash MX 2004 professional is that it

supports the Alias Text feature (see Figure 3.4).This feature makes small-sized text more

readable, for it aligns the text outlines along pixel boundaries. The text does not need to

be aligned on whole X or Y coordinates. Also there is no need to purchase fonts, as this

feature works on all fonts installed on the machine.

However some things need to be considered while aliasing text with the Alias Text

feature. If the user has Flash Player 7, then the Aliased text feature works with static,

dynamic, and input text. But if the user has Flash Player 6, then this feature only works

with static text. At the time of creating this project. the latest version of the Flash player

available for the Pocket PC was version 6.

The Aliased Text feature does not improve the readability of text less than 8 points. In the

case of some fonts, using type styles like italic or bold can reduce the readability ofthe

Aliased text at small sizes. Sans serif text. such as Verdana or Arial, appears clearer at

small sizes than serif text.

Sound

For Pocket PCs the less sound the better, because sound takes up precious processing

power. However this project was built for children, so in order to make the project

interactive and fun for children. sound effects for buttons and scanning were added. MP3
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compression with a bit rate of l6kbps and quality of "fast' was used. It is important to

test sound on the Pocket PC. since it might sound differently on a desktop. The speakers

in a Pocket PC aren’t very powerful, so sound effects need to be tested for audibility on a

Pocket PC, as they are sometimes difficult to hear.

Buttons

Buttons in Flash should be designed differently for the Pocket PC. There is no mouse in

the Pocket PC, so there is no mouse pointer. When the user interacts with a Pocket PC, a

tap on the screen is a mouse click. A button “rollover” state should not be used as the

rollover state might remain after the tap (Macromedia. 2003).
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Figure 3. 5 Main Menu buttons (Parts Figure 3. 6 Sub Menu buttons (Leaf

has been tapped on) has been tapped on) .

The buttons hit area should be made large enough for a quick stylus tap or for the user to

tap with a finger (see Figure 3.5 and Figure 3.6).



ML in Flash

XML is Extensible Markup Language. It is becoming the standard of exchange of

structured data for most Internet applications. Just like HTML. XML uses tags to mark up

or specify text. While in HTML tags are predefined, in XML the tags are not predefined

(e.g. <plant>Tomato</plant>). XML specifies the structure ofthe information not the

way it is displayed, so the same XML can be reused for different applications. Every

XML tag is called a node that could have attributes. A node that is inside another node is

called a child node. The XML document has a hierarchical tree structure.

When an XML file is loaded into Flash. an object model is created that allows the data to

be manipulated and easily extracted (Tupper, 2002). XML is a good option for loading

large amounts of external data.

Optimization

Pocket PC devices still don’t measure up to desktop or laptop computers in terms of

performance. Content therefore needs to be optimized to work better on a Pocket PC.

A higher frame rate means a larger file size. A larger file size puts more Strain on the

processor. Due to hardware limitations on the Pocket PC, adequate playback can be

achieved at a frame rate between 12 and 15 fps (Watrall & Herber, 2003, p. 765). The

current project uses a frame rate of 12 fps.
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Flash uses vectors to display content. In the case of a Pocket PC, using vectors can strain

the processor. The more the vector curves are manipulated. the more processing power is

required (Macromedia, 2003). It is better to use bitmap images instead of vectors while

creating animations in a Pocket PC. The sliding scan door in the current project is a

bitmap image. For better performance it is better to limit animation while creating content

for a Pocket PC.

It is a good practice to load external files like JPG and SWF into the Flash movie. as this

minimizes the file size of the Flash content and provides more easily updateable content

for the user. All the plant images in this project are stored in an external folder and

imported when needed‘into the Flash program using the “loadMovie” command.

Screen Size and FlashPack

Drawbacks of using the PIE (Pocket Internet Explorer):

A majority of Pocket PC devices including the one used for this project have a screen size

of 240x320. By default if one wants to display an SWF file on a Pocket PC one will have

to embed the SWF file in an html page and use PIE (Pocket Internet Explorer) to view

this page. The drawback to this method is that there are two areas in the Pocket PC 2002

U] that cannot be utilized for content (see Figure 3.7).
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Figure 3. 7 Screen Size in Pocket Internet Explorer (PIE)

These are the caption bar at the top of the screen and the menu bar at the bottom of the

screen. These bars remove 26 pixels each offthe vertical resolution. Therefore, in order

to design content for a Pocket Internet Explorer that fits on one page, the page size cannot

exceed 240x263. Because of a scroll bug in the PIE, one cannot use the full 268-pixel

height. Afier the page height exceeds 263 pixels the vertical scroll bar appears. This

reduces the screen width to 229 pixels. Switchng off the address bar can provide an

additional 23 pixels, but since turning it off is optional one can‘t design the page to use

that space. An additional 11 vertical pixels can be lost if the Flash movie requires a

horizontal scroll bar.
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If one wants the user to enter text information, an additional 80 vertical pixels are lost, so

that the screen can accommodate the SIP area (Soft Input Panel). This is the area that has

the keyboard and block recognizer. Generally content is sized at 230x250. so that it

appears without scrollbars when the address bar is turned Off.

FlashPack:

It is possible to view full screen Flash content in a Pocket PC and avoid being limited by

the size constraints ofthe PIE. One method is to use the Macromedia Flash Standalone

Player (SAP). The SAP is a client-side application installed in the Pocket PC that allows

the developer to create Flash projectors that run on the Pocket PC. The disadvantage is

that it costs $499 per year to license the SAP. This license needs to be renewed yearly.

Another method to avoid the issues associated with the PIE is to use third party programs

that create full screen stand-alone executable files.



 

 

 
 

  

 

Figure 3. 8 FlashPack Screen Shot

One such third party program that was used in this project is called FlashPack (see Figure

3.8), a product created by HandSmart (http://wwwhandsmartcom). FlashPack allows the

developer to easily create full-screen stand-alone executable files from SWF files. It is

relatively cheap, about $89.95 for the standard edition. However FlashPack requires the

device to already have Flash Player for the Pocket PC (not the stand-alone player). The

Flash player is freely available at the Macromedia website.
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Setting Screen Size:

There are two ways to set the screen size when creating a full screen Flash movie for the

Pocket PC. One way is to manually set the movie size to 240 x 320. First create a new

Flash movie by choosing File> New. Select the flash Document option. Once the new file

is open, go to Modify> Document. Then set the width to 240 and the height to 320.
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Figure 3. 9 New from Template Screen Shot

Another method is to use templates (see Figure 3.9). Macromedia Flash MX professional

2004 comes with a series of templates for mobile devices. To set the screen size of the

Flash movie using the template, go to File > New. Click on the Templates tab. Choose

Mobile Devices fi'om the list. Select the template that matches your Pocket PC. In the

case of this project I chose the iPAQ 5440 full screen template.



CHAPTER 4

PRODUCTION PROCESS

User Interface

The interface for this project was designed with the same color scheme as the 4-H

Garden’s website. The limited screen size (240x320 pixels) imposed several restrictions

  

 

 

while designing the interface.
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Figure 4. 1 User Interface

I kept the layout fairly simple (see Figure 4.1). The scan button and the home button were

placed on the top and a small text box was placed between them. This text box provides
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scanner status information. The main body of the interface has four areas. The picture

display area displays the image. Right below the picture display area is the text

description area where text description related to the image is displayed. Below the text

description area there are four main navigation buttons-Info. Parts, Cycle. and Uses.

Clicking on these main navigation buttons changes the submenu that appears on the right-

hand side ofthe interface. The submenu buttons contain an icon and text to indicate what

they signify. Images in the picture display area are changed by clicking on the submenu

buttons.

EVB Program and XMLSocket connection

Clicking on the eVB program initializes the Plant Scanner. This enables the scanner and

brings up the Flash user interface. The XMLSocket connection is established and the

Flash user interface is ready to use. When the scan button in the user interface is clicked.

the reader is in read mode. If there is a tag within its’ read range, the tag data is read and

transferred to the Flash program via the XMLSocket connection.

XML Data

The data present in a tag is a unique serial number. The reader reads this data and passes

it to the Flash program. An external XML file contains a look-up table that associates

each serial number with an XML file containing plant information. The look-up table is

initially loaded into the Flash program. When a tag is read the XML file corresponding to

the serial number in the look-up table is loaded into the Flash program. This XML file is

parsed by the Flash program and utilized to display information. In this way all the data
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to be viewed is external. Information about new plants can be easily added without

modifying the flash program.

Snippet of the XML data from the look-up table:

<tag>

<EOO7000011ED99E9 xfile="file:///xml/tomato.xml"/>

<EOO700001 1ED99E6 xfile="file:///xml/marigold.xml"/>

</tag>

Snippet of the XML data for plant information:

<parts>

<root img="file:///imgs/marigoldroot.jpg" description="This is a marigold root."/>

<stem img="file:///imgs/marigoldstem.jpg" description="This is a marigold stem."/>

</parts>

One thing to note while using FlashPack to access other files is that FlashPack does not

accept relative paths while loading external file. It needs the absolute path e.g.

file:///imgs/marigold.ipg instead of imgs/marigold.jpg.

Working

The Flash program is designed to make the whole scanning process fun and interactive

for children. When the user presses the scan button the scanner is “activated." When this

scanner is activated the act of waving it in front of an RFID tag triggers a scan event.
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Figure 4. 2 Scan door closed Figure 4. 3 Scan door opening

When there is a scan event. sliding doors cover the picture display area and sound efi‘ects

are audible (see Figure 4.2 and Figure 4.3). The text box at the top provides feedback to

the user like the various steps that are being taken to scan and download information.

When this process is completed, the sliding doors open to reveal a picture of the plant

that has just been scanned along with general information about the plant. The name of

the plant remains in the text box at the top.

This general ‘Info‘ includes the name of the plant. its‘ scientific name. and some other

information. The user can view more information about the plant by using the four main

navigation buttons below the text description box. Pressing the “Parts‘ button reveals a

set of buttons on the right hand side. By pressing these ‘Parts’ submenu buttons. the user

can view images of the various plant parts, which include the root, stem, leaf. flower,
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fruit, and seed in the picture display area. Corresponding text description is available in

the text description area. Similarly by clicking the ‘Cycle’ button, the user can view what

the plant looks like in spring. summer, fall. and winter. By pressing the ‘Uses’ button. the

user can view what that particular plant is used for. For this project we have broadly

categorized uses as beauty. food. bio-agent, medicine, arts and crafts, and fun.

The menu buttons are highlighted to indicate what section the user is seeing. Every time

the user wants to scan a new plant, she has to press the scan button and then wave the

device over a tag.
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CHAPTER 5

USER TESTING

Method

This study took place in the 4-H Children’s Indoor and Outdoor Garden at Michigan

State University. An eleven-year old boy, an eleven-year old girl, and an eight-year old

girl participated in the study. The two girls had never used a PDA before. The boy had

used a PDA before. Norm Lownds, the 4-H Children’s Garden curator, accompanied the

group through the garden. The participants were observed using the Plant Scanner for

approximately 20 minutes.

RFID tags were placed on plant stakes, which were placed next to three plants, marigold.

tomato, and pansy. The marigolds were blooming. The tomatoes were not. Since the

pansies were not in the Indoor garden, we decided to put the pansy tag in the Outdoor

garden. The PDA was placed inside a rugged case. This cover also protected the RFID

reader. The plastic screen cover was removed since the screen was warped, which made it

difficult to see the interface.

Introduction to Study

The children were told that they were going to test a new product in the Outdoor and

Indoor gardens. They were told that there were blank tags in the gardens and that they

should wave the scanner over the top of the tag. The students were asked to think aloud,

35



as they went as a group around the garden. They were told to take turns using the device.

Norm said that they could explore the Plant Scanner project first before scanning a tag.

During the introduction the children seemed interested in the device. After being given

the tool, the two eleven-year olds focused intently on the scanning device. The father of

the two girls was interested and soon came over and looked at the device. When the

father came over. the younger sister was standing away from the two eleven year olds.

Her father told the eight year old that, “she should be watching too.”

Sam looked comfortable holding and using the Plant Scanner. He pressed the parts

button. clicked on roots. then flower, then seeds, and then clicked on the cycle button.

He then clicked on each season. Later he went to the plant Uses section. Sam clicked on

all the buttons. Jill stood beside Sam and looked at the Plant Scanner too. They both liked

the smiley face in the Uses section. Sam said that he wanted to look at the actual plants.

Jill was the next to hold the device. She quickly clicked around the interface in a linear

order. She didn’t read the text. Sue was the last to test out the plant scanner. Compared to

Jill and Sam, she spent less time with the scanner.

Inside the Indoor Garden

Norm led the group to the marigold plant. Sam held the Plant Scanner and waved it in

front of the plant. Nothing happened. I asked Sam if he could figure out what he needed

to do before he waved the device. Sam looked at the interface for an instant and said,



“press the scan button." He then pressed the scan button and heard beeping. At this point

Sam bent down and waved the scanner across the RFID tag. The two sisters did not

gather around Sam when he stood up. I asked Sam if the picture in the scanner matched

the plant in the garden. Sam replied yes. Sam was able to provide the name ofthe plant

when prompted.

After clicking through the interface, Sam handed the scanner to Jill. At this point, Norm

and Sam started talking about a tall flowering plant nearby in the garden.

Jill clicked quickly on all the parts buttons and then went to the seasons. I asked her what

plant information was available. She said parts, cycles, and uses. I asked her if she had

noticed that the text information kept changing. She said that she hadn’t and then began

to look again at the text descriptions.

Norm asked them to look for other plants with tags but soon directed them to the tomato

plant. Sam gave the PDA to Jill who then successfully scanned the plant without being

given any instructions. Jill looked through the interface quickly and in linear order. She

went to the uses section button and noticed that nothing was there, became confused, then

clicked on the parts button and looked at all the parts again.

Jill then gave the scanner to her sister. Sue initially moved fi'om parts to cycles and then

to the uses but didn’t click on the sub-menus. Sue pressed a few buttons and soon lost

interest.
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Norm asked the children if they knew all about the tomato plant. Sam then looked back at

the interface.

The two older children were holding the stylus like a pencil, while Sue held it in a closed

fist. Despite these differences, all three were able to easily maneuver around the interface

with the stylus. Both the eleven years olds looked very relaxed using the scanner.

In the Outdoor Garden

An RFID tag was placed beside the pansy plants in the outdoor garden. Sam scanned the

Pansy plant without any instructions. Norm asked Sam if he noticed what the text said in

the start screen. Sam read the description and said that pansies don’t do very well in hot

weather. Norm asked the group when they thought the pansies had been planted.

Pointing to the pansies, Norm said that they had been planted last October, and that they

were in bad shape because it had been hot recently.

Because it was raining, Norm suggested that we go under the tent and work with the

scanner. The scarmer, at this point. was already loaded with the pansy plant information.

Sam, with scanner in hand, sat down and began clicking through the environment. He

rested the scanner on his knee. Sam read the descriptions ofthe pansies. After clicking on

the description of the pansy in the fall, Sam paused and had the other girls look at the

little pansy. The girls smiled and said it looked like a mushroom. Sam then looked at the

picture ofthe pansy fruit. I asked him if he had ever seen a pansy fi'uit before, and he
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replied that he didn’t know that pansies had fruit. Norm said that they did and that he

would go and see if there were any fruit on the pansies in the garden. Sam got up to go

with Norm. but Norm told him that he must wait until the others were ready. Sam

continued to look at the pansy information and laughed after reading that pansies were

able to “live through winter, even in Michigan.” Sam was working primarily alone

during this time. He later handed the Plant Scanner to Jill.

Jill looked at the Pansy uses and then went to the first button, beauty. Norm told the

group that the pansy picture for beauty was taken right where we were sitting. Jill went to

Pansy-food and saw a muffin. Sam said yum. Because both Sam and Jill had been

through the garden chefprogram earlier that day, they knew that pansies could be eaten.

Jill didn’t think that pansies tasted very good. The two sisters began using the interface

together. Jill went to pansy fun and read the text, ‘can you see a face.’ Norm asked her if

she could see the face. She and Sam said they could see the face and Jill pointed to the

picture on the screen. Jill gave the scanner to her younger sister, but Sue was content to

hand it back to her and watch.

I asked the group if the pansy fruit was like the marigold fruit. They didn’t remember so

Norm went back to retrieve the RFID tag for the marigold plant.

Norm returned with the tag, and Sam scanned it. Sam went to the uses and then to

marigold fun. He read that the marigolds have fim names. He said he didn’t know that

marigolds have other names. He read the name French vanilla and thought that
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information was cool. Sam asked Jill if she knew they had other names. She said that she

thought they were only called marigolds. Norm asked Sam if he knew what the names

refer to. Sam thought they probably refer to their smell. Norm said that the names

probably refer to the color, but it would be a good idea to check on that. Norm asked the

group if they knew what French vanilla ice cream looked like. Sam said it was like a

cream. Norm said that the names probably did not refer to the smell, since all marigolds

smelled alike.

Then Sam looked at the parts. Sam said that the marigold roots looked strange and

clumpy. I asked him if he had seen other roots like that. Sam said he hadn’t. I told him

that its’ strange appearance was probably was due to the attached mud.

Sam looked at the stem and asked whose finger had been photographed. Sam liked the

color shades and said that the striped look of the stem was cool. He then looked at the

leaves image. and even turned the Plant Scanner horizontal to take a closer look. He then

looked at the marigold fruit image and said that he hadn’t seen anything like that before.

Sam then went to flowers section and read that the flowers had a variety of colors. A

creamy white flower was mentioned in the text. He said that flower was probably the

French Vanilla variety. Sam thought the marigold seeds were cool. He handed the Plant

Scanner to Jill.

Jill looked at the Marigold uses. Jill thought it was interesting that the marigolds kept the

bugs away. Sam too thought it was cool that marigold kept bugs away.
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After asking them questions about the Plant Scanner program (see exit interview), the

kids were interested in going back and looking at the fruit of the pansies. Kneeling down,

Norm opened one ofthe pansy fruits that still had seeds. All three children became very

interested. Sam picked up another fruit to see for himself. The group then wanted to see

marigold fruit; we went to the marigold plants. Norm opened marigold fruits to show the

seeds. All three kids held out their hands, all wanting to hold the seeds. Norm said that

each plant has many flowers. He counted the number of flowers on the plant. The plant

had more than 25 flowers. Norm then said that there were many seeds in each flower.

Norm pointed to a huge marigold that had even more seeds than the smaller one they had

just opened. Norm placed marigold seeds in Sam and Sue’s hands. Sam said that he

wanted to take the seeds home with him.

Exit Interview

How wouldyou use the plant scanner?

- For science projects. to learn more about plant parts, to find out a plant‘s uses

Didyou like the colors?

- All the kids said yes.

What didyou like about the plant scanner?

- Jill said that she liked the uses section the best. She said she didn’t know that marigolds

kept bugs away.
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Didyou like the Pictures?

- All the kids said yes.

What were interesting thing about Pansies?

- They didn’t know they had fruit.

- They knew that pansies could be eaten.

What were interesting thing about Marigolds?

- They didn’t know marigolds kept bugs away.

- They didn’t know that marigolds had different names.

- They thought the seeds were cool.

- Sam thought the stem was cool too.

Was the scannerfun to use?

- All three said yes.

Was the text easy to read? Was the text was clear?

-All three said yes.

Was the scanner easy to use?

- They said it was easy to use.



Where else could use it?

- They said they would use it in school for science projects.

Suggestions?

They wanted more of the “interesting text.” Sam mentioned that the text for marigolds

was interesting and gave information of various colors of marigolds, but in other places

the text was not informative. One example that Sam gave was the text belonging to the

marigold seed.

Analysis

The study suggests that when there are more than two people in a group, the Plant

Scanner Project works better outdoors. The Outdoor Garden promotes more collaborative

activity with groups ofthree because it offers room for the children to walk around, and

stand beside one another when working with the Plant Scanner. In the Outdoor Garden,

the children were more likely to show one another something they found interesting.

Outdoors the children could also scan a plant and then sit down and navigate slowly

around the interface. The children were more likely to read more and ask more questions

when they were sitting down. Because the Indoor Garden is in a more confined space, the

group of three had difficulties sharing the Plant Scanner. Indoors the children were

navigating more hurriedly and not reading the text. The study suggests that because of

the Indoor Garden’s limited space, it might be better for groups of three or more to use

the Plant Scanner in the Outdoor Garden.
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The children had no difficulties holding the Plant Scanner and using the stylus. Even the

eight year old did not have difficulty using the Plant Scanner. The scanner was not

dropped or put down on the ground at any point during the study. The children did feel

more comfortable using the Scanner when they were sitting on the ground.

The children navigated through the interface with little or no instruction. They more or

less tended to follow a linear pattern of navigation. More time was spent with images that

had more descriptive text. ‘Interesting’ text descriptions, like pansies surviving the

Michigan winter for example. were more likely to be shared. They all enjoyed the sounds

and the graphics in the interface. There were no technical difficulties during the study.

The images and text came up quickly. The sound effects were audible.

The scanner worked well because ofNorm’s guidance and expertise. Norm asked key

questions which motivated the children to look at more information on the Plant Scanner

and led to interesting discussions. His prompting questions helped the children think

more deeply about plant biology. The mix of virtual and real was effective. The children

were able to see certain plant parts in the device and then actually look back at the

physical plant to observe even more closely. The children enjoyed this process.

Games and learning scholars are concluding as they study games and learning that a

digital game in isolation will not have nearly so powerful a learning impact as a game

preceded by and/or followed up by guided interpretation and group activities to reinforce

and highlight learning content. Technology plus a guide/teacher/coach can go beyond the
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impact of technology alone (Jenkins & Squire. 2003). The guide can pick up on

individual child interests. or events of the moment, to encourage further exploration and

wonder. The Michigan 4-H Children’s Garden guides field trips throughout the

year. Based on this limited but promising user observation, the plant scanner facilitates

interest and inquiry into unseen dimensions of a plant which is normally visible at one

point in its life cycle. The presence of an involved guide combined with the plant scanner

heightens child interest, involvement, and learning from the experience.

Other Issues

The scan range is reduced when the protective cover for the reader is put in place. When

the reader is held parallel to the tag the read range is about 3 to 4 inches. When the

scanner is held perpendicular to the tag the read range is even less about 1 to 2 inches.

Without the protective cover the read range is about 5 to 6 inches.

45



CHAPTER 6

FUTURE

Future Implications for the Plant Scanner Project

The current project uses data stored locally. A future modification ofthe project could be

to have the data on a server and data access through a wireless network. The PDA being

used for this project already has an in-built wireless card. If there is a strong wireless

signal in the garden, then data for a potentially unlimited number ofplants can be viewed

in the plant scanner without worrying about storage space. The XML file contains the file

name ofthe image and its’ location, so the XML file could be easily modified to contain

the URL ofthe images. In addition, the XML file itself could be stored on the server

making the system truly dynamic. It could then be possible to easily add more and more

plants without modifying the Flash program.

Some extra features like what insects are harmful to the plant in question, what are

favorable grth conditions, plant problems, comparisons between plants, and plant

growth rate could be added to the Plant Scanner Project.

Future studies should look more closely at individual differences and ways to use the

Plant Scanner to promote collaborative learning. It would be useful to work with

classroom teachers and experts in the 4-H Children’s Garden on ways that the project

could be integrated into science curricula. A potentially useful feature could be the ability
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for users to save certain information to a server, which they could access later. or beam

information to other plant scanner users in the garden.

High school students who attend 4-H Children’s Garden summer programs could be

enlisted to gather content and lead tours through the 4-H Children’s Garden. It would

also be interesting to find ways to integrate the Plant Scanner with other 4-H Children’s

Garden activities like Plant Problems and with online activities at the 4-H Children’s

Garden website.

Future implications for other Handheld Projects

The use ofRFID tags, or location sensitive equipment, can enhance tours that are

normally guided. Technologies like GPS and similar positioning systems or RFID tags

could be used as city guides, park guides, and museum guides. In the future the devices

will be smaller. Already cell phones are equipped with more functionality and this will

only improve. It is likely that in the future users will have one device that will integrate

various technologies, which serve all their mobile needs. I expect that these devices will

be smaller. less expensive. and more powerful.
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